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Introduction

Photo Mechanic is a simple tool for organizing editing and captioning 
images

The application will allow you to quickly edit large groups of photo-
graphs and select and organize your favorites. You can caption photos, 
even transmit directly from with the program.

This tutorial is designed to quickly get you familiar with the key 
features of Photo Mechanic. It is NOT designed to detail every single 
feature of the program.
IT is specifically written for Photo Mechanic 5 and is current as of 
August 2016

This tutorial will look at these key features of Photo Mechanic

1  Set Photo Mechanic Preferences

2  Import photos from a camera to your computer or harddrive

3  Sort and edit photos

4  Caption photos

5  Copy or move photos to a different location

•
NOTE:  This tutorial was 
written for the Mac OS. 
The program should be 

very similar on a 
Windows computer
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If you want to dive deep 
into the features of Photo 
Mechanic check out their 
Wiki @
http://wiki.camerabits.com/

Photo Mechanic Preferences
Configured properly you can use Photo Mechanic quickly and easily 
to import photos from a camera’s SD card, sort and select your best 
images and then edit in Photoshop or another image editing software 
application.

Open the Photo Mechanic Application. You’ll probably see an empty 
‘contact sheet’

Note the contents of your computer on the left. This is one way to 
navigate in Photo Mechanic as we’ll discuss later.

For now, go to the top and select Photo Mechanic 5>Preferences...

http://wiki.camerabits.com/
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Note there is a dropdown menu for different sets of preferences. 
Many of the settings can be configured to your personal choices 
and are pretty self explanatory.

Under General I suggest checking ‘Show Ingest dialog’ under ‘On 
Mount of Camera Disk:’

This will automatically open the Ingest function when you connect 
to a camera or card.
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You can explore the many preference settings and make changes 
that fit your workflow.

But for the most part, starting out, you can simply use the defaults.

One other setting I recommend:

Under ‘Launching’ set the default application to whatever photo 
editing software exists on your computer – Photoshop for example. 
This will allow you to automatically open an image in Photoshop 
directly from Photo Mechanic.

Watch a  2:13 video on setting preferences

http://www.willyurman.com/teaching/handouts-2/photo-mechanic-video-tutorials/#preferences
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Getting Photos from your 
camera to your computer

There are many ways to get your images from your camera to your 
computer.  You can simply plug in your camera or insert your card 
and then open the folders and drag the images to your computer.

Photo Mechanic provides a way to make that process quicker and 
seamless AND allow you to add information (metadata) at the 
same time.

Using Photo Mechanic’s Ingest function you can copy image files 
to your computer while at the same time renaming the files, ap-
ply caption information and even copy to two places at the same 
time. (Allowing you to back up your files to a second hard drive for 
example)

INGESTING

Open Photo Mechanic
Attach you camera or insert your card into your computer or card 
reader. 
If you set your preferences, the Ingest window will open automati-
cally. If not, go File>Ingest from the menu.

From the Ingest window, you will set some options and then click 
‘Ingest’ and Photo Mechanic will copy photos off the card to your 
computer.

•
Metadata is ‘data 

about data’. 
For photos it means 
attaching information 
about your photo-

graphs, digtally, to the 
image file. 

You can add caption 
or copyright informa-
tion to every file, au-
tomatically, in Photo 

Mechanic.
Metadata is search-
able - making it a 

powerful tool for or-
ganizing your photos.

•



PhotoMechanic

      Tips & Tricks

Penn State
College of Communications created August 2016

8

1. Select the card you want to ingest. NOTE if you have other hard-
drives connected to your computer they will show up as well. MAKE 
SURE you select the camera card.

2. Choose a destination - This can be anywhere on your computer or 
external harddrive. IF you want, you can select a secondary destina-
tion as well.

3. In general, use the default ‘ignore - copy all photos into same desti-
nation’. This puts all your photos in one folder.

4. Select the option that works best for you. I often put photos in a 
dated folder, but sometimes I want them in a folder with a name.

5. You can rename your photos - Check the sequence box and then 
‘Set (seqn) var’ to choose a number sequence.

6. Click to apply a caption to all your photos using the stationary pad. 
You can then add to individual captions later as needed.

7. Click Ingest to start

Watch a 3:22 video on ingesting in Photo Mechanic

http://www.willyurman.com/teaching/handouts-2/photo-mechanic-video-tutorials/#ingest
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IPTC Stationary Pad
You can add a bulk caption to all your images at one time (returning 
later to add specifics to individual images)

In the Ingest window, select IPTC Stationary Pad and make sure the 
‘Apply IPTC Stationary Pad to Photos’ is selected.

Why Do This?
 1. Will save you LOTS of time later on
 2.  Makes all your images immediately searchable.  

 
Description/Caption:
Enter the basic facts of the assignment and your photo credit. Use 
AP style for captions. Always include where and when the photo was 
taken as well as background and context.

City, Location, State, Country
All of this is searchable later and can be useful

•
Good caption infor-
mation makes your 
photos more valu-
able and easier to 
find.  
You can’t really 
search for photos, 
at least not yet. BUT 
you CAN search for 
the attached meta-
data.  
The context that 
captions give a 
photo make it more 
useful and valuable 
to editors.
Always include dates 
and locations. Make 
sure you spell names 
correctly and pro-
vide complete infor-
mation about what 
is happening in the 
photograph.

•
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Date
Date the assignment was shot. Change this from ‘Today’ if necessary.

Photographer, Credit, Copyright
Extremely important to have your name attached to your images. 
TIP
   ‘option G’ will create the copyright logo

Email and URL
scroll down and enter your email and website if you have one.

Working With Your Photos

Once you’ve ingested your photos you can begin to edit. 

Photo Mechanic calls the page of thumbnails a Contact Sheet. 
The term comes from the days of film. A roll of film would be cut into 
strips and placed directly on a piece of photographic paper in the dark-
room, usually held flat, in contact with the paper, with a piece of glass.  
This single print would show rows of images from a single roll of film.  
Photographers would select their favorites and then make full-size prints 
of just those images.

Typically each folder of images can be displayed as a single contact 
sheet and can contain dozens, hundreds even thousands of images.

•
IF you use an exter-
nal drive you can save 
this information and 
load it each time you 
use Photo  
Mechanic. (Unfortu-
nately the lab com-
puters erase data 
each night so you 
can’t save it on the  
computers)

   Click ‘Save…’ at 
the bottom left to 
save a caption.  Click  
‘Load…’ to install a 
previously save cap-
tion.

•
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Here’s an example of a Contact Sheet with my dog once again the 
model.
You can have multiple Contact Sheets open at once. Notice the tabs 
at the top.

Open new folders of images as Contact Sheets by going 
File>Open Contact Sheet or by navigating to the folder using the 
navigator at left.

Notice how a few images are marked with tags, ratings and color 
classes.

Tags  The small check box in the lower right of each image
Ratings One to five stars below each image
Color Classes  Eight different colors that can be applied to a photo

You can use these in any combination as you select and edit your 
photos. This allows you to quickly edit a large collection of photos as 
you choose the best images. 

•
It is always quicker if 
you can learn key-
board shortcuts on 
the computer.
The keyboard is 
faster than using a 
mouse or trackpad.

For Editing in Photo 
Mechanic:
‘T’ - will tag or un-
tag a selected photo 
or photos.

Control 1 - will 
add one star. (Con-
trol 2 will add two 
starts, etc.)

⌘ 1, ⌘ 2, ⌘ 3, etc 
– will add a color 
class to a photo or 
photos.

•
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Rollover any image and you’ll see the following:

The arrows at the top allow you to rotate a photo 

The ‘i’ button will bring up the caption window

The magnifying glass will give you large preview of the photo
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•
You can select multiple 

photos in a contact sheet.
Use the Shift key to se-
lect a group all in a row, 
hold the key and select 

the first and last to select 
them all.

Hold the Command key 
to select photos that 
aren’t in a sequence

•

The ‘i’ button brings up the caption window. 

If you applied a caption at ‘ingest’ it will be here. You can make any 
changes or additions you like. If you are captioning multiple images use 
the ‘Save and’ buttons to advance through your selection.

If you have a caption you want to apply to more than one photo click 
the ‘copy’ button go to the next photo and click ‘paste’.

You can save a caption for future use or load a preexisting caption us-
ing the buttons at the bottom.
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•

•

The magnifying glass brings up a large preview image

The large view allows you a close look at your photo.

Information on the right includes your camera settings - this can be 
helpful to see what worked or what mistakes you may have made.

The zoom function will allow you a very close look at your image - 
to check for sharpness for example.

The histogram is useful to see if you exposure is accurate.

At the top are a series of buttons. Notice you can bring up the 
caption in this view. You can also open the photo in Photoshop or 
another image editing app. 
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•
Photo Mechanic has a 
spell checker built in. 

Use it.
Spelling matters. Also 

always double check the 
spelling of names and 

places and other proper 
nouns.

Mistakes are embarrass-
ing to your subjects and 

to you.
•

With practice you can learn to quickly edit and sort and caption pho-
tos in Photo Mechanic.

Some photographers will edit in a series of steps.  Say for example 
you shot 200 images at an event. They might go through and tag 20 of 
them as ‘favorites’ using either the tag tool or color coding them.

One strategy would be to copy those 20 into a new folder.  DON’T 
move the photos, copy them. This leaves a complete, untouched set 
in one place.

From there, they may ultimately select the one or two images they 
want as their final selection - depending on the final use. 

Again, copy those images to a new folder. Making copies means you 
always have an untouched original in case something goes wrong.

MOVING/COPYING PHOTOS

1. Select the photos you want to copy to a new location.  If you’ve 
tagged or color coded or rated them, you can choose to view that 
selection. 
For tagged photos, use the dropdown menu at the top of the contact 
sheet and change ‘All’ to ‘Tagged’
You can also go Edit>Select Rated, or Select Tagged, or Select Color 
class.

2. Highlight all the selected photos

3. Go File>Copy/Move Photos...  (⌘Y)
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•

•

Copy/Move

The Copy/Move box looks more complicated than it is. 

The above settings will work in most situations.

1. Uncheck the Apply IPTC Stationary, otherwise your caption will be 
overwritten by your default caption.

2. Uncheck Move photos(delete originals).  UNLESS you have a 
good reason for deleting the originals you want to make a COPY

3. Check Always pick destination.  

Click ‘Copy’ and you’ll then be asked where. You can create a new 
folder anywhere you like and Photo Mechanic will copy the images to 
the new destination.

Watch a 9:20 video on editing images in Photo Mechanic

http://www.willyurman.com/teaching/handouts-2/photo-mechanic-video-tutorials/#editing
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That’s an overview of Photo Mechanic’s basic functions for editing 
and organizing your photographs.

With a little practice it can be a great tool – you’ll work faster. 
Which means more time for other things like taking more photos!  
(or playing video games, hanging with friends, sleeping or studying 
for other classes)

•
Photo Mechanic has 
some other interest-
ing features you can 
explore on your own:

1. Email photos di-
rectly from the app

2. FTP photos direct-
ly from the app

3. Export photos as 
web galleries

4. Apply GPS coor-
dinates to photos for 
mapping.

5. Code replace-
ment - a system for 
using codes for cap-
tioning. Popular with 
sports photographers 
who caption a lot of 
photos on very tight 
deadlines.


